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1.   CONNECTION BETWEEN THE LABELLER AND PC/INDICATOR 
 
RS232 serial connection (9-pin connector): 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

PC PORT      PRINTER PORT 
 

2 RXD  --------------------------------------------------------- 2 TXD 
3 TXD  --------------------------------------------------------- 3 RXD 
5 GND  --------------------------------------------------------  5 GND 
6 DSR  --------------------------------------------------------  6 RDY 
8 CTS  --------------------------------------------------------- 8 RDY 
 

 
 
Parallel connection: the printer is supplied with a cable for programming through the parallel line. 
 
 
RS232 serial connection with the weight indicator: refer to the instrument’s technical manual for the connection. 
 
 

1.1   MINIMUM REQUIREMENTS 
 
Minimum requirements 
 
- Windows XP SP 2 (compatible with Windows Vista) 
 
- Microsoft .NET Framework v 2.0 
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2.   INSTALLATION OF THE PRINTER DRIVERS 
 

1. Insert the TSC CD, supplied together with the printer, in the CD ROM reader of the PC. 
 

2. The following window appears automatically: 
 

 
 

3. Select the “Windows Driver Setup” item and follow the procedure shown by the installation programme 
 

- If the window does not appear, read the contents of the CD and launch the "Setup.exe" file 
  

 
 

- Follow the procedure shown by the installation programme 
 
NOTE (it’s possible to carry out a quicker and simpler installation, described later on through the USB port). 
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2.1   INSTALLATION OF THE DRIVERS THROUGH THE USB PORT 

 
1. Connect the printer to the PC through USB port and turn it on 
 
2. The window will open automatically 
 

 
 

- If the window does not appear, open the control panel and double click on the “Add Hardware” item, otherwise 
go to point 3 

 

 
 

- Follow the procedure shown by the guided hardware installation programme and select the printer that is to be 
installed 
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- If the printer is not in the list, select the last item, “Add a new hardware device”, otherwise go to point 3 
 

 
 

Note: the name of the “SMTPLUS” printer is shown as “TTP246M PLUS”; 
the name of the “LP542S” printer is shown as “TDP-245 PLUS”; 

 
- Follow the procedure shown by the guided installation programme 

 
3. Insert the CD which contain the printer drivers  

 
4. Follow the guided procedure and press on the End key 
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2.2   INSTALLATION OF THE DRIVERS THROUGH THE SERIAL (COM) OR PARALLEL (LPT) PORT 
 

1. Connect the printer to the PC through the serial (COM) or parallel (LPT) port. 
 

2. Insert the TSC CD, supplied together with the printer, into the CD ROM reader of the PC. 
 

3. Open the control panel and select the “Printers and Faxes” item 
 

4. Click on “Add printer”  
 

 
 

5. Press on “Next” in order to start installing the printer 
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6. Select the “local printer attached to this computer” option , unselect the “Automatically detect and install my Plug 
and Play printer” option and press “Next” in order to continue 

 

 
 

7. Select “Use the following port”, configure the port to which the printer is physically connected, and press on “Next”. 
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8. Select the manufacturer (TSC) and the printer which one wants to install, confirming with the “Next” key  
 

 
 

Note: the name of the “SMTPLUS” printer is viewed as “TTP246M PLUS”; 
the name of the “LP542S” printer is viewed as “TDP-245 PLUS”; 

 
9. Follow the procedure shown by the installation programme; in the “Do you want to print a test page?” it is advisable 

to select “Yes” in order to see whether the printer is correctly installed. 
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10. Press on the “End” key.  
 

 
 

11. The window automatically opens; Confirm with the “OK” key 
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3.   SOFTWARE INSTALLATION 
 

3.1   INSTALLATION OF THE BARTENDER SOFTWARE 

 
1. Insert the TSC CD, supplied together with the printer into the CD ROM reader of the PC 

 
- The following window automatically opens  
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2. Select the “TSC BarTender Software Setup” item 
 

- If the window does not appear, read the contents of the CD and select the “BarTender” folder 
 

 
 

- Launch the “setup.exe” file 
 

 
 

3. Follow the procedure shown by the installation programme. 
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3.2   INSTALLATION OF THE DIAGNOSTIC TOOL SOFTWARE 

 
1. Insert the TSC CD, supplied together with the printer, into the CD ROM reader of the PC. 

 
2. Read the contents of the CD and open the “Utilities” folder 

 

 
 
3. Launch the “DiagTool.exe” file 
 

 
 
4. Follow the procedure shown by the installation programme 
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4.   BARTENDER SOFTWARE 
 

4.1   FIRST CONFIGURATION OF THE PROGRAMME 

 
1. Launch the programme, this window will appear: 

 

 
 

2. Select "Run the UltraLite Edition only." And click the "OK" button, this window will appear: 
 

3. Create a new label or click the "Close" button. 
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4.2   CREATING A LABEL 

 
4.2.1   SETTING THE PARAMETERS 
 

1. Run the software and select "Start a new label format…" 
 

 

 

2. Select "Blank label format" and click the "Next" button; 
 

3. In case of several installed printers, select the utilized printer and click the "Next" button; 
 

4. Select "Specify Custom settings" and click the "Next" button; 
 

5. Select  "Single Label" and click the "Next" button; 
 

6. Follow the procedure indicated from the programme; it will be possible to set according to one’s needs: 
 

- side edges; 
 

- label shape; 
 

- size, orientation and effects; 
 
 
 
ORIENTATION EXAMPLE: 

       100 (width) 
 

 
 
Physical dimension of the label:    120 (length) 
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Select the print orientation of the label: 
 
   Label seen on PC monitor    Printed label 
 

 
 
 
Portrait 
 
 
 
 
 
Landscape 
 
 
 
 
 
Portrait 180 
 
 
 
 
 
Landscape 180 

 
 
 
 
 
 

7. When the settings are done click the "Finish" button. 
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4.2.2   ENTERING A TEXT 
 

1. To enter a text click on the  button 
 

2. Put the mouse cursor where you want it in the label and with the left key of the mouse click and confirm. 
 

 
 

3. Click twice with the left key of the mouse on the created text: the following window will appear: 
 

 
 
 
 
 
 
 
 
 
 
 



 18 

4. Set the data source: 
 
 

 
 

Screen Data Fixed text, set in the "Screen Data" field 

Date Not to be used 

Time Not to be used 

Printer Code Template Field Variable text, filled in during printing with variable fields 

Label Object String  Not to be used 
 

DESCRIPTION: 
 

a) Fixed text: text entered in the label layout, which is always printed. The fixed text can not be substituted by 
other texts in the printing phase 
If one selects the data source as “Screen Data" it is necessary to enter the text to be printed in the "Screen 
Data" field: 
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b) Date: Not to be used 
 

c) Time: Not to be used 
 

d) Printer Code Template Field: Variable text, filled in during printing with variable fields (see section 2.5.1) with 
the desired data. 

 
If one selects the data source as “Printer Code Template Field " it is necessary to enter, in the "Field Name" 
and "Sample Data", the abbreviation which identifies the field in the label layout and the sample data which will 
be displayed in the label layout: 

 

 
 

e) Label Object String: Not to be used 
 

5. Select the Font window and set the font type and dimensions: 
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!! IMPORTANT !! 
 

Use only the TSC selectable fonts. 
 

NOTE: 
- the TSC 5 font does not allow printing the lower-case letters. 
- to expand a font in height select the (Cond.) font, to expand it in width select the (Exp.) font 

 
6. Select the Position window and set the text rotation: 

 

 

 
VISUALIZATION ON PC  

 

 
 
Rotation of the text 

0 

 

90 

 

180 

 

270 

 

 
NOTE: if all the label fields have the same orientation, different from the “0” type, it is advisable to use the “print 
rotation” function (see point 6 of paragraph 4.2.1). 

 
7. Click the OK button to confirm the text. 

 
8. To move the text in a different position keep the left key of the mouse pressed, drag the text where you want it on 

the label and release the left key to confirm it. 
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4.2.3   ENTERING A BAR CODE 

 

1. To enter a bar code press the  button 
 

2. Put the mouse cursor where you want it on the label and with the left key of the mouse click to confirm. 
 

 
 

3. Click twice with the left key of the mouse on the created bar code; the following window will appear: 
 

 
 

4. Set the data source (see the point 4 of the section 4.2.2) 
 

5. Font window and set the font type and dimensions (see the point 5 of the section 4.2.2) 
 

6. Select the Position window and set the text rotation (see the point 6 of the section 4.2.2) 
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7. Select the Bar Code window and set one of the suggested barcode types: 
 

 
 

8. Select the dimensions and the density of the barcode bars: 
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9. Click on the “Print Method” button: 
 

 
 

10. The following window will appear: 
 

 
 
11. Select the “Bar codes and human readable text controlled by the printer” option and click on OK: 
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12.  Select the Human Readable and select the visibility: 
 

 
 

Full The barcode value will be printed also as a text 

None The barcode value will be printed only as barcode 
 
 

13. Click the OK button to confirm the barcode. 
 

14. To move the bar code in a different position keep the left key of the mouse pressed, drag the bar code where you 
want it on the label and release the left key to confirm it. 
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4.2.4   INSERTING A PICTURE 
 

1. To enter a picture press the  button 
 

2. Put the mouse cursor where you want it on the label and click with the left key of the mouse to confirm. 
 

 
 

3. Click twice with the left key of the mouse on the created text; the following window will appear: 
 

 
 

4. Select the picture to enter in the label by pressing the "Select picture" button. 
 

NOTE: The image can also be coloured, but when it is printed, it will automatically be converted in a 
monochromatic BITMAP image. 

 
5. Select the sizing Method, the picture dimensions and effects. 

 

6. Select the "Position" window and set the picture rotation (see the point 6 of the section 4.2.2). 
 

7. Click the OK button to confirm the picture. 
 

8. To move the picture in a different position keep the left key of the mouse pressed, drag the picture where you want 
it on the label and release the left key to confirm. 
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4.2.5   ENTERING A LINE/BOX 

 
1. Use the keys 

 

 To enter a line 

 To enter a box 
 

2. Press one of the keys and create the desired figure in the label by keeping pressed the left key in order to start; 
then release the key to end. 

 

 
 

3. Click twice with the left key of the mouse on the created element. 
 

4. By choosing the  option, the following window will appear: 
 

 
 

5. Set the coordinates of the initial and the final point, and the line length and thickness. 



 27 

6. By choosing the , the following window will appear: 
 

 
 

7. Set the box dimensions and thickness, and the line and fill colours 
 

8. Select the "Position" window and set one of the following rotations: 0, 90, 180, 270. 
 

9. Click the OK button to confirm the object. 
 

10. To move the element in a different position, keep the left key of the mouse pressed, drag the picture where you 
want it on the label, and release the left key to confirm. 
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4.2.6   ALIGNMENT OF THE LABEL FIELDS 
 

If one should need to align the label fields like the one in the example below, one should: 
 

 
 

1. Select all the fields to be aligned, by choosing the “Select all” item from the "Edit" menu 
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NOTE: if one needs to select just a few fields, keep the "SHIFT" key pressed of the PC keyboard and click on the 
desired fields. 

 
Each time that one selects more than one field, the alignment function bar will appear: 
 
 

: Alignment on the left 
 

: Alignment on the right 
 

: Alignment from above 
 

: Alignment from below 
 

: Alignment on the centre horizontally 
 

: Alignment on the centre vertically 
 
: Centres in respect to the upper and lower margins of the label 
 

: Centres in respect to the left and right margins of the label 
 
: Horizontal equidistancing of the fields 
 

: Vertical equidistancing of the fields 
 
 
 

NOTE: For the alignments from above, below, on the right and on the left, the programme aligns the fields to the 
farthest in respect to the selected direction. 

 
2. Carry out the desired alignment: 
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4.2.7   PUTTING IN ORDER THE VARIABLE PRINT FIELDS INSERTED IN THE LABEL 

 
The order of the variable fields corresponds to the order in which the relative object has been inserted in the label. 
 
To help identify it, enter an increasing index which identifies the order of entry in the “Subject Name”, inside the properties 
of each subject with a variable field: 
 

 
 
- After this, to identify the position of a field click on “Data origins” in the window on the left: 
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- By selecting the object inside the label, the window on the left will show the name of the object, corresponding to 
the order of entry. 
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4.2.8   LABEL PRINTOUT TEST 

 
Once the layout label has been made, it is advisable to make a test print of one, in order to check the actual printed result. 
To execute this operation, one should: 
 

1. Connect the labeller to the PC (see paragraph 1). 
 

2. Open the label that one wants to print 
 

3. In the “File” menu select the “Print” item: 
 

 
 
 

4. Select which printer you want to use in the list shown under the "Name" box: 
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Note: it’s possible to configure various printout parameters (see section 4.2.9) 
 

5. Select "Options", the window below appears: 
 

  
 

6. Unselect the "Print to file" option, if selected, and press on Print  
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4.2.9   CONFIGURING THE PRINTOUT PARAMETERS 

 
1. Open the printout menu (see section 4.2.8 point 3) 

 
2. Select the “Document ownership” key. 

 

 
 

3. The following window will appear 
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4. Now it’s possible to configure various printing parameters: 
 

a) Printing speed 
- Select the “Options” item  
 

 
 
- Configure the desired speed from the “Print Speed” menu 

 
b) Density (intensity) 

- Select the “Options” item 
 

 
 

- Configure the desired Density (intensity) found in the “Intensity” menu 
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c) Printing with the thermal labels or with the use of the RIBBON (thermal transfer) 
- Select the “Pack” item 
 

 
 

- Configure the print method found in the “Method” menu 
 

d) Peel-off sensor, cutter, and tear-off 
 

- Select the “Pack” item 
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- Configure which type of action that needs to be made after the printing 
 

TEAR-OFF ACTION Select this option if one does not want to use the peel-off option. 

STICKER ACTION Select this option if one wants to use the peel-off option with the relative sensor (optional) 

CUTTING ACTION Select this option if one wants to use the cutter option (optional) 

 
e) Offset 

 
It’s possible to customise the offset in order to allow the label to further advance: 
- Select the “Pack” item 

 

 
 

- Set the desired offset from the “Feed Offset” option 
 
 

 
 
 

4.3   PRINTING THE LABEL THROUGH THE WEIGHT INDICATOR 
 
After verifying that the label respects the desired layout, in order to print it through the weight indicator, it is possible to 
follow one of the procedures below: 
 
STORAGE ONTO THE WEIGHT INDICATOR 

1. Execute the printing of the label on a file and save it inside the indicator; in this way it is possible to enter the print 
blocks directly in the label layout. If the label contains logos or images, one should download these directly in the 
permanent storage of the labeller, remove these from the created file in order to not finish the memory in the 
indicator, and recall these with a specific command. 

 
STORAGE ONTO THE LABELLER 

2. Execute the download of the label onto the labeller; in this way the label will be saved onto the permanent memory 
of the labeller and, to print the label, one should programme the indicator in order to recall it and pass to it all the 
variable set fields and the number of labels which one wants to print. 
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NOTE: in case of external programming of a label for DFW or DGT indicators one should follow procedure 2 (for further 
details refer to the programming of the printouts on these indicators). 
To simplify the programming, in other cases, it is advisable to follow procedure 1. 
4.3.1   STORAGE IN THE INDICATOR 
 
In order to download the label into the printer, follow the example below: 
 

1. Create the label, which must be made up of only fixed fields. 
The fixed fields must be texts, print blocks or bar codes. 
For example: 

 

 
 

In this programming mode, it is possible to enter directly the desired print blocks into the label, following the entry 
procedure of the fixed tests (paragraph 4.2.2 point 4.a). 

 
NOTE: the print blocks must be entered in the label in the following format: 

 

@[xxx] 
 

In which:  @ = ASCII decimal 064 character. 
 [ = ASCII decimal 091 
XXX = desired print block; for the list of the indicator print blocks, refer to the technical manual 
 ] = ASCII decimal 093 character 

 
In regards to the bar code, one should enter a fictitious value corresponding to the maximum number of the 
acceptable digits, which will be modified in the .txt file later on. 

 
For example "1234567890" 
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2. Once the label is created, one should print if from PC, I the “File” menu select the “Print” item: 

 

 
 

3. Under the "Name" box select the printer to be used: 
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4. Select "Options", the window below appears: 

 

  
 

 

5. Select the "Print to file" option and "Show printer code at the end of the print job" and click the Print button: 
 

  
 

NOTE:  
If one has launched the BarTender through the Dinitools.net (from version 04.04.00), by unselecting the "Print to 
file" and "Show printer code at the end of the print job" options and by clicking the Print button, it is possible to 
import automatically the file that contains all the commands to be transmitted to the labeller, after the closing of the 
graphic file; refer to the DINITOOLS manual for further information. 
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In this case one has to make sure that the labeller is connected correctly to the PC and that the physically 
connected port corresponds to the selected printer model and wait for the end of printing before closing 
the program. 
 

6. Click the Print button, the window below appears 
 

 
 

7. Select the Auto Overwrite option and click the Print button 
 

8. Once the printout is made, the Output.prn file will open automatically; this contains all the commands to be 
transmitted to the labeller and to be saved in the indicator. Label example converted into the "Output.prn" file: 

 

 
 

9. If, like in the example, a bar code in the label is inserted, one should modify the fictitious value attributed to the bar 
code with desired print block: 
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10. If a logo or image has been introduced, one should download these in the permanent memory of the labeller, 
remove this from the created file in order to not finish the memory available in the indicator, and recall it with the 
PUTPCX or PUTBMP command (see section 4.3.1 for the storage procedure and recall of the image with the 
PUTPCX or PUTBMP command). 

 
11. Copy the Output.prn file in the folder in which the printouts will be stored. 

 
!! IMPORTANT !! 

Copy the Output.prn file in a folder different from the original one, which serves to store the created label. Each 
time that one launches a printout or a label download from the BARTENDER programme, the Output.prn file is 
automatically overwritten with the new transmitted data. 
 

12. Through the Dinitools.net, import the "Output.prn" text file. 
 

13. At the end of all the imported data, add the end print block (300). 
 

 
 

14. Send the label to the indicator, in the desired print ticket; in this way one loads onto the indicator all the commands 
for printing the label. 

 
15. Disable the instrument terminator, since the printing on file automatically adds a CRLF character at the end of each 

command string. 
 

IMPORTANT: if one modifies the format in the DINITOOLS editor, one should have the DINITOOLS terminator set 
on the CRLF (see the DINITOOLS manual) 

 
REMEMBER ALSO TO: 
- configure the communication protocol (the default labeller is configured at 9600,n,8,1). 
- set the CTS signal at a low level 
- disable the terminator 

 
16. Launch the printout from the indicator. 
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4.3.1.1   STORAGE OF AN IMAGE ON THE LABELLER 

 
Premise: the printer supports only the storage of the images in monochromatic PCX or BITMAP formats. 
Follow this procedure through the serial (COM) or USB port. 
To store the image on the labeller, follow the procedure below: 
 
Example through the USB port: 
 

1. Open the Diagnostic Tool . 
 
2. Make sure that the USB port is selected in the “Interface” box. 

 
3. Press on the “Get Status” button in order to verify whether the printer is ready and Read to receive the setup. 
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4. Select the “File Manager” window making sure that the “BMP” or “PCX” format is selected in the “File Type”. 
 

 
 

5. Select the desired image using the “Browse” key. 
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6. Click on the “Download” key; the image is uploaded and saved on the printer. 
 

 
 

7. With the Get key it’s possible to view all the files in the labeller memory. 
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8. To cancel all the files in the labeller, press the “Format ” key 
 

 
 

To recall the image of a label, go to the following section ( 4.3.1.2) 
 
 

4.3.1.2   RECALLING THE IMAGE OF A LABEL 

 
If the image was inserted in the graphic format, one should copy the image coordinates, in other words, the first two 
numbers following the BITMAP command, for the subsequent use with the PUTPCX or PUTBMP command. 
 

Then one should delete it from the file created by BARTENDER through the printing on file, in other words, delete the whole 
BITMAP command as highlighted in the example below: 
 

 
 
and recall the image using the PUTPCX or PUTBMP command followed by coordinates, and the name of the file. 
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For example: 
 

 
 
NOTE: the image is printed with the original dimensions; if necessary, resize the original image; then, reinsert the modified 
image in the graphic format in order to check the dimensions before the storage. 

 
 
 

5.   RESET OF THE LABELLER MEMORY 
 
To reset the labeller, in other words, cancel all the print formats in it, one should: 
 

SMTPLUS LP542S 
1. Turn off the labeller. 1. Turn off the labeller. 

2. Keep the PAUSE and FEED keys pressed and turn on 
the labeller. Release the PAUSE and FEED keys 
when the “Initializing…” message appears in the LCD 
display. 

2. Keep the FEED key pressed and turn on the labeller. 
Release the FEED key when the LED of the labeller 
starts to blink with a green colour: 
Amber � Green � Amber � Red (5 blinks) � 
Amber (5 blinks) � Green (5 blinks) � Green/Amber 
(5 blinks) � Red/Amber (5 blinks) � fixed green. 

3. The printer has been reset. In the case of a 
STORAGE ON THE LABELLER, all the print formats 
must be reloaded. 

3. The printer has been reset. In the case of a STORAGE 
ON THE LABELLER, all the print formats must be 
reloaded. 

4. Carry out the alignment of the labels (see the following 
section). 

4. Carry out the alignment of the labels (see the following 
section). 

 
 
 

6.   ALIGNMENT OF THE LABELS  
 
The first time one uses the labeller it is advisable to execute a self test in order to detect the space between one label and 
the other and to measure its length. To do this, one should: 
 

SMTPLUS LP542S 
1. Turn off the labeller. 1. Turn off the labeller. 

2. Keep the PAUSE key pressed and turn on the labeller. 
Release the PAUSE key when the “Calibrating…” 
message appears in the LCD display. 

2. Keep the FEED key pressed and turn on the labeller. 
Release the FEED key when the LED of the labeller 
starts to blink red: Amber � Green � Amber � Red 
(5 blinks) � Amber (5 blinks) � Green (5 blinks) � 
Green/Amber (5 blinks) � Red/Amber (5 blinks) � 
fixed green. 

3. Turn off the labeller and turn it back on. The first label 
is ready to be printed. 

3. Turn off the labeller and turn it back on. The first label 
is ready to be printed. 
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7.   TROUBLESHOOTING 
 

PROBLEM SOLUTION 

THE LABELLER PRINTS 
LABELS INFINITELY  

1. Turn off the labeller  
If one uses the STORAGE ONTO THE LABELLER, verify the coherence between the 
entered variable fields and the ones transmitted by the indicator as well as the 
presence of all the terminators; check that a coherent number of labels has been 
specified. 

2. Reinstall the programme 

THE LABELLER DOES NOT 
PRINT ANY LABELS 

1. If one is using the STORAGE ONTO THE LABELLER, make sure that the indicator 
terminator has been disabled. 

2. Check that the labeller is powered correctly. 
3. Check the connection between the labeller and the indicator/PC 
4. The printer does not contain any format (if one uses the STORAGE ON THE 

LABELLER). 

 
THE PRINTED LABEL IS NOT 

ALIGNED 
1. If one does not use the extraction sensor, the first printed label may not be aligned, 

since the labeller has to find again the alignment. 
2. Make sure that the label size is the programmed one. 

 
THE LABELLER PRINTS A 

WHITE LABEL 
1. Make sure that the printer head has been lowered. 
2. Make sure that the printer is fed through its own power adapter. 

THE LABELLER IS BLOCKED 
AFTER HAVING PRINTED A 

LABEL 

If the extractor sensor is enabled, it has remained that way: the label has been extracted 
too quickly, or, with a too intense light, the presence of the label has not been detected 
correctly. 
Turn off the printer to restore the correct functioning. 
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8.   AVAILABLE CHARACTERS 
 

 
 
 

To find the decimal code relative to the desired character, one should sum the line value with the column one. 
For example: the ä character corresponds to 128 + 4 = 132 decimal. 
   the ? character corresponds to 48 + F = 63 decimal. 
 


